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1. Introduction

1.1Star Bearing Company

The Star Bearing Company (SBC) is a leading bearings manufacturer that has multiple plants across the
world. Their manufacturing process can be split up in three lines, which represents the different
components in their bearings: the inner ring, the outer ring and the rolling elements. Each of the product
lines have different stations such as turning, chamfering, face grinding, bore grinding and ring polishing.
They also have more than one machine in most of the stations:

Shop floor structure
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SBC decided to build a hybrid AF model that is process oriented and that is composed of equipment-based

elements:
Quter Inner Rolling Heat
Ring Ring Element Treatment

Station 1
*Rough Furnaces

Grinding

. (I — 1,
i~ Chromium "1 1 | LR, IT_'Q. I Bnm i -
1 alloy slugs AISI M’ L_,' s I_4 | UJB. &

I - = I
I_ 52100 _ 1 | “—— : | = | :‘5
1

=3 & 1
Rough grinding {Heat treatment; , Fine grinding  Polishing I

inspection, and
packing station

Station 1 Station 1

* Tumning +Turning

Station 2 Station 2 Station 2

*Rough + Chamfering

*Heat
Grooving Treatment

Station 3

+Heat
Treatment

« Fine Grinding
Treatment

Station 4
« Polishing

» Face Grinding + Face Grinding

Station 3 {Slation 3

Station 5

*Race
Grindin,

Station 5

ough + Bore Grinding
£l

Station 8
» Race Honing

Station 6
+ Polishing

% |
% |
% |
% |
% %

They have chosen this structure because the stations might change depending on the product they are
manufacturing. SBC is quite happy with their AF Structure, but they would now like to create meaningful
KPI's
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Introduction

1.2Lab objectives

In this lab, you will start with an existing AF Structure that models the Star Bearingl Company assets. You
will create OEE metrics using the Analysis Service and learn a few tricks along the way. With this OEE
calculation setup, the SBC will be able to see almost in real-time what’s the OEE instead of looking at the
KPIs for the last hour.

Once you complete the AF structure, you will add the missing OEE metrics in an existing Pl Vision display.

In addition, the SBC asked for a weekly report on their OEE metrics. You will use the PI Integrator for
Business Analytics along with Microsoft Power Bl Desktop to create the report and use it to find out which
machines are problematic.
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2. Directed Activity Exploring the AF Structure

2.1Context

In this section, you will build and complete the Star Bearing Company AF structure, add the OEE metrics
and backfill the results to get the OEE history of all their assets.

2.2Step by step tasks

e
e QOpen Pl System Eprorer from the Start Menu bar.

e Make sure you are connected to the Start Bearings Company AF database by clicking on the
database [@Datebese | pytton:

e Select Star Bearings Company then click on OK:

Select Database X

& New Database X Delete Database 7 Database Properties (g} Edit Security

Asset server: |@ PISRVO1 ~ ‘ -
Databases:
Fiter R~
Name Description Last Modified
@Conﬁgurahon A store for configuration data.  2/18/2019 7:45:40 PM

" Star Bearings Company 2/18/2019 7:46:46 PM

e The AF Structure of SBC has two hierarchies: the one described previously in 1.1 and a second

organized by equipment for their maintenance team. The elements in the Equipment List are
referenced elements:

Elements

-y Elements
 Configuration
= (3§ Star Bearing Company
oo
(@ Bore Grinding
- (G Chamfer
- (@ Face Grinding
- (G Fine Grinding
G Heat Treatment
B @ Lathe
b ) ENCLathe001

i &) CNCLathe0D2
t ) CNCLathe003
L CNCLathe0D4
i~ g CNCLathe0d5
L £ CNCLathe00s
b G Polishing
- (G Ring Polishing
G Rough Grinding
 Rough Grooving
=l (@ Inner Ring
£l ( Station 1
i () CNCLathe004
- [ CNCLathe0DS
Lo [ CNCLathe0Ds
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The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

e Select Elements — Star Bearing Company — Inner Ring — Station 1 CNCLathe004 and click on
attributes, examine the attributes of that particular lathe:

@ WWPISRVOT\Star Bearings empty 1 (Time Context: *) - P System Explorer (Administrator)
File  Search View Go Tools Help

@Database = Query Date ~ (® @ OBack ﬂ‘( CheckIln <} « ,ﬁ Refresh | "3 Mew Element ~ Mew Attribute
Elements CNCLathel04
= 5 Elements General Chid Elements  Attributes  ports  Analyses Notification Rules  Version
i~ (@ Configuration
=] ﬂ Star Bearing Company
[~ (J Equipment List |E°f(er
&= & Inner Ring |? ¢ | 3| &/ £ Name 2| Value
- [ Station 1
[ B ClCLathe004 = Category: <None>
& CNCLathe005 3 k-3 ;O Bad Part Count 52
(J CNCLatheO0& L i
- [ Station 2 =1 CydeTime 540 s
- (J Station 3
- & Station 4 5 € | ¥ Machine State Running
i @ Station 5 s B& |¢F PartCount 23
[H- [ Station
[ (P Outer Ring Ll =] Product 6921
[H- (F Rolling Element
& i
(- (3, Element Searches & RunringTime 3600
4 Element Attribute Search Results 1 = Category: Asset Management
=] Machine Type Lathe
= | MachineMame CNCLathe004
=1 No 004
=1 ProcessLine Inner Ring
=] Station Station 1
=] Category: Maintenance
=] Installation Date 5/30/2016 5:00:00 AM
=1 Last Maintenance Date 12/14/2018 6:00:00 AM
= | Manufacturer TAKISAWA
=] Model M13

Each equipment has already some PI Point and static reference attributes configured. The Part Count
and Bad Part Count are calculated at the end of each hour. The RunningTime is also calculated hourly
and represents the amount of time the machine has been in a Running state. Explore the structure and
compare it to the shop floor diagram in 1.1. Once you are familiar with it, navigate to the Library then
Select Element Templates:

@ YWRISRVOT Star Bearings empty 1 (Time Context: *) - Pl System Explorer (Adrr
File View Go Tocols Help

@ Database [ QueryDate - © @ | D Back H, Checkin ) «

Library

@ Star Bearings empty 1

- Templates

= [y Element Templates

El & Equipment

R - (§ CNC Lathe Template

L
------ @' EquipmentGroup Template

------ (g Global Configuration

- ( Line Template

. () Station Template

o b [ R JE
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The Templates are already ordered by template inheritance. That means that the CNC Lathe Template and
Rough Grinder Template share the same attributes listed in the Equipment Template. Take note there is
also a template for the stations and production lines.

There are also some Enumeration sets that were already built by the SBC. The Machine State attribute
values type is the Machine Status Enumeration Set:

General

Name: |Mad1ine Status

Desaiption: |

[] Hexadecmal — Security

Value MName
Running

3 Idle

1]
1
2 Stopped
3 Unplanned Stopped

In this lab, the machines can be Running, Idle, Stopped or in an Unplanned Stopped but you could always
define additional states in your own AF Structure.

With this basic AF Structure, you are going to add some relevant KPI’s related to the OEE and once built,
you are going to create visual dashboards in Pl Vision and also leverage Microsoft Power Bl to drill down
the data. Once you are comfortable with the AF structure, move on to the second chapter to start building
the OEE metrics.
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The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

3. Directed Activity — Adding the OEE Metrics

3.1Context

SBC would like to add the OEE Metrics for all their equipment, stations and production lines. In short, OEE,
developed in the mid 1990’s, enables the monitoring of plant floor productivity and improvement of the
efficiency of a manufacturing process. OEE is composed of three different metrics: Availability,
Performance and Quality. There are many ways of calculating the OEE, here is how Star Bearings Company
decided to define these metrics:

Metric Description Formula

Availability Percentage of time that an equipment is up and | Operating Time / Planned
running (hourly) Production Time

Performance | Actual yield to the target yield Part Count / (3600/Cycle Time)

Quality Percentage of good units that are produced Good Part Count / Part Count

OEE Availability*Performance *Quality

3.2 Step by step tasks

3.2.1 Create the OEE metrics for the machines

e Navigate to the Library and select the Equipment Template. Because the OEE needs to be
calculated for all the machines, we will place the Analysis at the base template level. Select the
OEE Metrics Analysis:

@D \\PISRVOT\Star Bearings Company - PI System Explorer (Administrator]
File View Go Tools Help

@ Database [ QueryDate ~ © @& | Back H, Checkln =3 « [2]Refresh | @ New Template -

Library Equipment
=] r Bearings Company General | Attribute Templates Ports | Analysis Templates  Notfication Rule Templates
=) [@ Templates :
-+ ( Element Templates ] Name: OEEMe
5 (& Equipment | B N Description:
EquipmentGroup Template c
t :
lobal Configuration il OFE Metics aesens
@ Line Template fi0 SIMULATION - Machine State Analysis Type: @) Exg
(@ Station Template foa  SIMULATION - Part Production Enable analyses wh
i EventFrame Tempistes fsa__SIMIILATION - Runnine Time

.- [ Madel Templates

- i Transfer Templates Example Element:  Star Bearing Company\Inner Ring\Station 5\BoreGrinder01

#-- @ Enumeration Sets
i ', Reference Types —
& Tables |-—adc anew variable

[ Table Connections

Name Expression

= (] Categories I
' There OEE Metrics analysis were already setup with some calculations in order to
® avoid typing them later on. We will provide a full explanation on what they do
. shortly.
Tip
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You can create upfront the varAvailability, varQuality, varPerformance and varOEE variables and choose
to map them as new attributes (Availability, Quality, Performance, OEE) with their output history saved:

File View Go Iools Help
@ Database B Query Date - © @ () Back H, Checkln 3 « [&]Refresh | @ Mew Template ~
Library

(&8 Star Bearings Company
= Templates

Equipment

General  Attribute Templates Ports  Analysis Templates  Notification Rule Templates

: Name:
£ [ Element Templates ul ame:

i -V Equipment 8 & Name Descripti
(% EquipmentGroup Template . Categerii
: (B Global Configuration ifts  OEE Metrics ategori
i b (G Line Template fea  SIMULATION - Machine State Analysis
i G Station Template fta  SIMULATION - Part Production Enab
E ;\:’ZF;::;W;EI:;HD\EES fier SIMLILATION - Runninng Time.

&

- 7§ Transfer Templates
@) Enumeration Sets
‘#, Reference Types ﬁ
- [ Tables Add a new variable

Example Element:  Star Bearing Company\lnner Ring\Station 5\BoreGrinder001

- B3 Table Connections MName Expression
- (1 Categories
@:Elzsic:t:egumes Segintnterval IF(Minute("*") = @) OR (Minute('*') = 1)
@ o oute Lategonies THEN ParseTime(Concat("T+", Hour('*-1h"), "h+1s"))
B e Soe Giadne S L ic S
Raference Type Categgms D Attribute Template Properties X
ey
|59 Table Categories EndInt: 1 IF(Minute("*") = 1) 9 . @ e)
ndInterva THEN ParseTime(Concat("T+", | Save Output History: @ Yes ) No
ELSE '+
Name: OEE
) IF(Minute('**) - @) OR (Minute( Description:
ElapsedTimeSec THEN 3593
ELSE((Minute('*") - Minut Data Server: FeServerds v
PostingTime Value Type: Pouble :
If(Minute( *") <> 1) THEN Begir
( ( ) ) 21 APl Point data reference attribute template will be created. )
varAvailability | Ty oK o

varPerformance

vartual ity Tune an evnression

e Try to fill in the availability, performance and quality equations according to the table above. If
you are all set, compare your equations with the solution on the last page of this document.
Once you have validated your results, make sure that the calculation Scheduling is set to
periodic (1 minute) and that the Output Time Stamp is set to variable: PostingTime:

Scheduling: () Event-Triggered (@) Periodic

Period: 00h 01m 00s Output time stamp override: PostingTime
) Advanced options X

Cutput Time Stamp

) Trigger Time

Execution Time

Relative to Trigger Time:

@ Variable: PostingTime =

Automatic Recalculation

[ Recaleulate analysis for out-of-arder input events

Cance
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The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

3.2.2 OEE Calculation scheduling explain

Let’s take a look at the OEE data on the below trend, the black dots represent 3 availability values that
have been recorded (0.7 @ 1:00 PM, 0.3 @ 2:00 PM and 0.6 @ 3:00 PM). The normal behavior of any of
our visualization tools such as Pl Vision is to draw the line in red. Do you think this is correct for our OEE
calculation?

0.7

0.6 |
0.3

1:00 PM 2:00 PM 3:00 PM

The trace in red is not correct because each of the values represent the calculated metric for the past
hour. The OEE was at 0.3 for the 1:00 PM — 2:00 PM interval and not 0.7.

Therefore, the correct trace is the green one. If you query the system within each interval you will retrieve
the correct value in the green trace. But, if you query the value at the start of the interval you will receive
the value of the previous one, which is incorrect. For example, if you query the value between 1:00 PM
and 2:00 PM the value is 0.3 but at exactly 1:00 PM the result will be 0.7 and not 0.3 for the green trace.
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To remediate to this issue we have provided a small algorithm that acts like a totalizer. It recalculates the
OEE every minute and changes the output timestamp depending on the minute it’s executing the
calculation. The second benefit to that methodology is that you are getting almost real-time OEE metrics
besides having to wait for the result of the past hour.

Add a new variable
Name Expression
aprEry o M very
BeginInterval IF(Minute( ) ?) OR (Mi u‘lL:e(" ) 1? . . .
THEN ParseTime(Concat("T+", Hour('*-1h"), "h+1ls™)})
ELSE ParseTime(Concat("T+", Hour('*'}), "h+ls"))
IF(Minute("*") = 1)
EndInt 1
natnterva THEMN ParseTime(Concat("T+", Hour{'*"'}, "h"))
ELSE **°
. IF(Minute("*') = @) OR (Minute('*') = 1)
ElapsedTimeSec THEN 3599
ELSE((Minute('*') - Minute(BeginInterval))®6@)-1
PostingTime
If(Minute("*") <> 1) THEN BeginInterval ELSE ParseTime(Concat("T+", Hour('*")))

If the current minute of the hour is different from one, the OEE value will be written with a timestamp of
the current hour + 1 second until the minute is equal to 1, where the value at the last hour + 1 second will
be re-written. In other words, the calculation is continuously re-writing the OEE value at every minute and
the final results are written when the minute is 0 and 1. This technique is mimicking a totalizer tag, it
writes “intermediate” values until the final value is saved:
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The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

5 Time Series Data a X
Archive  Sampled  Plot Summary Data Pipe
Attribute: |oee [
Start Time: *8h F=| » | End Time: l:l BBl &= =
Retrieval Type: | Time Range ~ | Boundary Type: | Inside ~
Filter: | | 01 show Fitered
Reset
Data E3
O 2?2 B & TimeStamp Value ~
» .. 2122019 12:00:00 PM |0.5625
Substituted po1g 12:00:01 PM | 0,525
2/12/2019 1:00:00 PM  |0.6125
4 |2/12/2019 1:00:01PM | 0,225
2/12/2019 2:00:00 PM  |0.2325
4 |2/12/2019 2:00:01PM | 0.625
2/12/2019 3:00:00 PM | 0.62604
4 |2f12(2019 3:00:01PM | 0,825
2/12/2019 4:00:00 PM | 0.8225
4 |2f12(2019 4:00:01PM | 0.5625 W
Trend S
® 0.5625
0.9
0.7
06 | ( —
0.5
0.4
0.2
2/12(2019 11:17:22 AM 8 hours 2{12{2019 7:17:22 PM
16 results returned in 0.0022861 seconds.
Close

The values with a  means that they have been substituted. In the list of archived values above you might
find odd that, the values at t+1s be a little off or seem rounded. This is due to the timing and frequency of
the input values (ex: part count). Returning the exact value is possible but would require a little bit more
tuning of the OEE equations and any of its calculated inputs. Real-life scenarios sometimes involve
complex calculations like the one described above.

e Before doing any “check-in” of the modifications, make sure you edit the attributes of each of
the OEE metrics. Add these to the OEE Category. Also, make sure you change step to 1 and that
compression is set to O:
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e Also, change the Point Name to Discrete.%Element%.%Attribute% if not already set. Add the
attribute to the OEE category and define the Unit of Measure (UOM) to percent. This step is

Tag Creation Settings it
FPoint Class: base ~ Import...
Point Type: Floats4 ~
Point Attribute Value o)
engunits
excdev 0.1
excdevpercent 0.1
EXCMEX 600
=] 1]
exdesc
future 0
pointsource Lab
ptsecurity piadmin: Afr,w) | piadmins: A{r,w) | PIWa...
scan 1
shutdown 1
sourcetag
span 100
step
typicalvalue 50
zZEro o]
v
Canc

important to be able to complete the next exercises:

Pl Point Data Reference

X

Data server:

| YeServer %

N

@ Tag name:

|piscrete. element. wattributew] [p | [ O

Tag Creation

|pc|nttype=FIoat64;sneD=1

O Atiribute: |

Urit of Measure

Source Units:
Value retrieval methods
By Time:
Relative time:
By Time Range:
Calculation basis:
Min percent good:
Preview
Example instance:

Configuration:

Value:

Read only

<Mone> ~

Automatic

[ ]

End Time
Time Weighted

a0

Select example instance

Group by: Category [ Template

Name: |OEE |
e Description: | |
Properties: <None > w
A Categories: OEE |
Default UOM: percent - |
Value Type: Double ~
Default Value: |[J % |
Data Reference: | PI Point ~
| Display Digits: |—5 |

| Settings...

\3eServer e \Discrete., %Elements. Yo tiribute
%g;pointtype =Float64; compressing=0;step=1
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The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

The configuration of the other attributes can be quickly changed using a copy/paste
of the configuration string:

Gemersl AMUDUE TENGIStES Ports  Anshysis Tempiates  Notficaton Rule Tempiates
Groupby: [ Category [] Template
[t £ ]| rame: Quaity
[ Tri[e Rneme Joesipton | etaut voke @ | escipton:
@ €1 (2 Categery: <hone> Properes: Hore> -
+ | g sadrartcount 0 Ems o= =
¢ [ ~
Ti 53 CydeTime s0s AT
ValeTipe:  [Im v
p o ovesoe (oot ey |
. Defaitiobe: [0
Part Count o |
@ Data Reference:  PLPoint -
4 Product wn
Dispiay Digits: -5
¢ | GGmumngime  [umngTimel.. 0
settngs...
B (2 Cabegory: Asset Mansgement
34 Macine Type 0

‘ Tiseserver: eAtrBute Y% Wl 1

Now that you have created the calculations and edited the attributes, make sure to check-in your
modifications and have a look at any of OEE attributes. You might see some “Pt Created” values, this is
expected as the OEE calculations are only triggered when an input change. The values will be backfilled
later on in the exercise.

3.2.3 Create the OEE metrics for the lines, stations and equipment groups

The OEE metrics have been created for the equipment but not for the stations, lines and equipment
groups. Navigate to the library — Station Template — Analysis Template and create a new rollup calculation
and name it Station OEE Performance. Select average, map the output to a new attribute and call it
Performance:

@ Y\PISRVO1\Star Bearings Company - Pl System Explorer (Administrator) —
File View Go Tools Help

@ Database [ QueryDate ~ © @ | (D Back H, CheckIn <2 « [#]Refresh | @ New Template ~ Search Element Te:
Library Station Template
@ Saf Bearings Company General Attribute Templates  Ports  Analysis Templates  Notification Rule Templates
- [@ Templates ) -
(=) [ Element Templates uil Name: Station OEE Performance
Bl [ Equipment © = Name Description:
i b (f CNClatheTemplate = - Categories
£ Rough Grinder Templat @' Station OEE Performance 2=
[ EquipmentGroup Template %@  Station OEE Availability Analysis Type: () Expression @) Rollup  (7) Event Frame Generation
(G Global Configuration @ Station Bad Part Count Enable analyses when created from template
;- G Line Templat= et Statinn Dart Count
iy Station Template
Event Frame Templates Example Element:  Star Bearing Compamy\Outer Ring\Station 1
Model Templates
- 48, Transfer Template: .
e @ ,;,Em;n;mrsim * Rollup attributes from Sample Child Element: | CNCLathe001 + | Group By: | None v
= " (@) Child elements of Station 1 () This element - Station 1
-~ (@ Bad Part Ressan . - Name Parent Element Categories
-~ @ Machine Status To select attributes set criteria below
. v Performance CNCLathe001
@ Machine Unplanned Downtime Ry Attribute Name: Performance
@ OFF Metrics Availability CNCLathe001 OEE
- @ Cperators iiout= Fer=bR ool o - Bad Part Count CNCLathe0D1 OFE
-~ @ Part Creation Flag Attribute Category: i CycleTime CNCLathe001
- @ Part Quality Hement Category: . Installation Date CNCLathe0D1 Maintenance
@ Products Last Maintenance Date CNCLathe001 Maintenance
@ Shift Information Element Template: -
- B Station status Machine State CNCLathe001
- %, Reference Types Select the function(s) to write to an attribute Machine Type CNCLathe001 Asset Management
- Tables Function Qutput(s) Value At Eval Value At Last MachineName CNCLathe001 Asset Management
-~ B} Table Connections (] 5um Manufacturer CNCLathe001 Maintenance
= (1 Categories ) N Model CNCLathe0D1 Maintenance
) ix:xz‘r::fﬂ;j; verage  Barforrance No CNCLathe001 Asset Management
~ d 1 Minimum NFE CNCT athaiN a3
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RONUP ATIIDUTES Trom Sample Child Element: | CNCLathe
(@) Child elements of Station T (™) This element - Station 1

N
To select attributes set criteria below ame

.  Performance Ch

Attribute Name: Performance I
Availability Ch
Attribute Level: Root Level v Bad Part Count ch
Attribute Category: v CycleTime Ch
Element Category: - Installation Date Ch
Element Template: @ Attribute Template Properties x b
£h
Select the function(s) to write to an attribute Save Output History: @ Yes No N
Function Outputis) Name: Performancd Er‘
[] Sum -
Description: Ch
BAverage Map Ch

, JeServerds v

[] Minirmum pRiaienes B b
[] Masimum Value Type: Double * | b
C i
[ [RCcut A Pl Paint data reference attribute template will be created, |,
[] Median [ ok ][ cancet |pn
[[] Population standard deviation | | Running lime Ch

e Don’t forget to change the step and compression settings, add the category and UOM like in the
equipment template:

Group by:
2 v| Mame: |Perf0rmance
i|# R Name 2 Description Default Value @ | Description: |
| Category: <MNones I Properties: <None >
=4 Element Name Pl Point Data Reference | categories: OEE
| Default UOM: ercent
€ | [=f Station Status Data server: |%5erver% v| e i
Value Type: Double
| Category: OEE @ Tagname: [Discrete. %eElemente. SeAtribute®s [ ][0
Default Value: 0%
¢ | & Availability Tag Creation
| | I | Data Reference: | PI Paoint
& pointtype =Floats4
i B c
¢ {Grerfomence O Atrbute; | 129 Cresion Settings x
¢ CE Quality Unit of Measu| . T
Point Class: base w Import... pointtype=F
| Category: Production Source Units:
Point Type: Floate4 bt
% | ¢ Bad Part Count
1 Value retrieva
4 | & Part Count Point Attribute Value
By Time: L
archiving 1
Relative tf | compdev 0.2
compdevpercent 0.2
By Time Rangg | compmax 28800
compmin 1]
Calculatio . I
compressing 0 | »
Min percel datasecurity piadmin: A{r,w) | piadmins: A{r,w) | PIwo...
descriptor
Preview digitalset
displaydigits -5
Example instal engunits
o 01
Configuration sxcoey
excdevpercent 0.1
Value: EXCMEX 600
EXcmin o
exdesc
~| Read onl
—— future 1]
pointsource Lab
ptsecurity piadmin: A{r,w) | piadmins: A{r,w) | PIWo...
scan 1
shutdown 1
sourcetag
span 100
step 1
typicalvalue 50
zero o
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Copy the Performance attribute, paste it and rename it to Availability:

@ i\ Company -
File View Go Tools Hap
@ Databiase [T Query Date ~ ® @ O Back O

, Checkin *3 v (5] Refresh | g New Temglate. - ‘i New Attibute Template

G st Bemngs Corgany

— @ Bement

(2] NosBcation Rude Categeries

— Sl Reference Trpe Cotegones
Bl Table Categeries

2l Category: CEE

| & ‘ & Performance |

‘0%

Genaral Atttz Templaes ports | Analyss Tespiates

Fter

[« i[# Rnime “Desapton  Defeult Ve

B Category: <None>
4 Sement liame o
& ﬂ-a Mew Child Attribute Template
B Cotegoryi P iy New Anibute Template
+  a@siull GotoAnalysis Template
o |qgel ®  Setw Dt Anrbute
L Categorze..
Limits.
[E—
Locstion of Sement Template
Copy Cel
Copy Path
2 Paste
¥ Delete..
S Properies

Categorize...

Column Visibility
Collapse All
Expand All

[#] Refresh

Paste

> Delete All..

Mew Attribute Template
Location of Element Template...

Health of Element Template...

Go to the Analysis Template, copy the Station OEE Performance analysis and paste it:

” & m MName

¥ X e

Mew

Delete

Preview Results
Backfill/Recalculate
Backfill/Recalculate Status
Go to Template
Reset to Template
Convert to Template
Copy

Paste

Check In

Undo Check Out
Check Out

Audit Trail Events...
Security...

&

[T o sum

mance S = Name
Past Count lﬂ . wailability
prformance
t Count X | Delete Bad Part Count
bue Cale @ Preview Results Dart Cruimt
- Bearing Con Backfill/Recalculate Star Bearing CompanyRolling E
I— Backfill/Recalculate Status
Go to Template from
Station2 Reset to Template sof Station 2 (7) This element
EEE Convert to Template s set criteria below
m 3 Copy |A\.ra|'lability
footlm | B Fove ot Lo
——— Check In [v: |
Undo Check Out r
¥ Check Out |
Audit Trail Events... n(s) to write to an attribute
to write to ar & Security.. ction Output(s
e []5um
Average Availability

Rename the Analysis to Station OEE Availability and make sure the output is mapped to the

Availability attribute:
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@ “WPISRVO1\Star Bearings Company - Pl Systern Explorer (Administrator)

File View Go Tools

Help
@Databa;e P Query Date - (© @ D Back

H, Checkin ¥ « [2] Refresh

@ Mew Template -

Library

Station Template

@ Star Bearings Company

= Templates

2 Element Templates
£# Equipment

(F Line Template

-- | Model Templates
4§ Transfer Templates

21 Enumeration Sets

- @ Bad Part Reason

- @ Machine Status

@ OEE Metrics
- [ Operators
.. (@ Part Creation Flag
@ Part Quality
- @ Products
--- @ shift Information
- @ Station status
i '#, Reference Types
- Tables
) Table Connections
= (] Categaries

(@] Analysis Categories
- Attribute Categories
Element Categories

-

Table Categories

() CNCLatheTemplate
Rough Grinder Templat|
(% EquipmentGroup Template
(% Global Configuration

E *@ Station Template
- Event Frame Templates
[&

- [ Machine Unplanned Downtime Re

(] Notification Rule Categaries
Reference Type Categories

General Attribute Templates  Ports

Analysis Templates  Notification Rule Templates

ull

@ = MName
Station OEE Performance
w@l Station OEE Availability
@' Station Bad Part Count
@' Station Part Count
ftg Station Status Calc
@' Station Status Sum
Ui Stetion OFE

Example Element:  Star Bearing Company\Outer Ring\Station 1

Rollup attributes from

(@ Child elements of Station 1 () This element - Station 1
To select attributes set criteria below

Attribute Name: Availability

Attribute Level: Root Level

Attribute Category:

Name: Station OEE Availability

Description:

Categories:

Analysis Type: () Expression @) Rollup () Ewent Fran

Enable analyses when created from template

v

Sample Child Element: | CNCLathe001 v | Group By: | None
Name Parent Element
v Availability CNCLathe001 OEE
Bad Part Count CNCLathe001 OEE
CycleTime CNCLathe001
Installation Date CNClLathe001 Maintena

Since the Bad Part Count and Part Count exist in the line, station and equipment groups, you will need to

create an Expression analysis to calculate the Quality. You also have all three OEE metrics; therefore,
you can calculate the OEE:

@D \\PISRVOT\Star Bearings Company - PI System Explorer (Administrator)

File VWiew Go Tools Help

@ Database [ QueryDate - ® @& Q) Back

H, Checkin %) « [¢]Refresh i@ Mew Template -

- >

Search Element Templates O

Library

@ Star Bearings Company
Templates

£+ (f Element Templates
= (% Equipment

~ (i Global Configuration
- [ Line Template
Vi, Station Template
- Event Frame Templates
@ Model Templates
1§ Transfer Templates
=~ [y Enumeration Sets
- @ Bad Part Reason
@ Machine Status

- (@) OEE Metrics
- B Operators
@ Part Creation Flag
- @ Part Quality
- @ Products
@ shift Information
@ Station status
e, Reference Types
Tables
Table Connections
- ] Categories

I @ CNCLatheTemplate
(@ Rough Grinder Templa
() EquipmentGroup Template

@ Machine Unplanned Downtime Ry

Station Template

General Attribute Templates  Ports  Analysis Templates  Notification Rule Templates

ul

@ @ Name
% Station OEE
W@t Station OEE Performance
W@  Station OEE Availability
@  Station Bad Part Count
@  Station Part Count
Jeo  Station Status Calc
@ Station Status Sum

Example Element:  Star Beaning Company\Cuter Ring\Station 1

Add a new variable

Mame:
Description:
Categories:

Analysis Type:

Station OEE

() Rollup () Event Frame Generation () SQC

Enable analyses when created from template

Evaluate

Name Expression

Value at Evaluatio Value at Last Trige Output Attribute

varQuality Convert(('Part Count'-'Bad Part Count')/'Part Count',"ratio") Quality ®
varOEE ‘availability’ * 'Performance’ * varQuality OFE ®

analysis for the Line Template and EquipmentGroup Template.
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3.2.4 Backfilling the OEE results

The Management menu in Pl System Explorer lets you manage your calculations in bulk. Filters can be

created to select only a subset of calculations:

@ \\PISRVOT\Ster Bearings Company - PI System Explorer (Administrator)
File View Ge Tools Help
@ Database [ QueryDate ~ ®© @) @ Back () [H, Checkln ) ¢ [£] Refresh

Management Analyses
Choose a type 12 total analyses selected (12 on this page) 1-120f12 (<[>
@® Analyses

Status & &  Element
() Notification Rules

/) @ star Bearing Company)\Ralling Element
Analysis Searches [v] @} Star Bearing Company\Outer Ring
+ X V] @ Star Bearing Company\Inner Ring
Al - ) f& Star Bearing Company\Rolling Element

Star Bearing Compar nner Rin

Enabled P I 9 Company\nner Ring

/) @ star Bearing Company)\Ralling Element
Disabled a* ] @ Star Bearing Company\Inner Ring
QEE Metrics £ V] @ Star Bearing Company\Rolling Element
EquipmentGroup OEE # ) @ Star Bearing Company\Inner Ring

[l Star Bearing Company\Rolling Element
Station OFE , 9 @ o Company\Roling E

/) @ Star Bearing Company\Outer Ring
Line OEE & o o

Star Bearing Company\Inner Ring

Name

Line Bad Parts Produced
Line Bad Parts Produced
Line Bad Parts Produced
Line OEE

Line OEE

Line OEE Availability
Line OEE Availability
Line OEE Performance
Line OEE Performance
Line Parts Produced
Line Parts Produced
Line Parts Produced

Template

Line Bad Parts Py
Line Bad Parts Py
Line Bad Parts Pt
Line OEE

Line OEE

Line OEE Availab|
Line OEE Availab|
Line OEE Perfon
Line OEE Perforn|
Line Parts Produ:
Line Parts Produ:
Line Parts Produ:

Enable | Disable selected analyses
Enable | Disable automatic recalculation for selected analyses

Backfill/Recalculate selected analyses

Start |*-30d =
End |* @

What should we do with existing data?

) Leave eisting data and fill in gaps

(@) Permanently delete existing data and recalculate
[ Recalculate dependent analyses

Recalculation will permanently delete all the
data within the time range. For event

e Create afilter for the Equipment, EquipmentGroup, Line and Station templates using the +
icon. Use the name field to filter out the only the calculations relevant to each element
template. For example the Line calculations all start with “Line” so the filter can be “Line*”.

@ YWWRISRVOT,Star Bearings Company - Pl Sys

File  Wiew

Go Tools  Help

aDatabase Eﬂuer}r Date + (U @ 6

Management

Choose a type
® Analyses

Motification Rules

Search Mame:

Line OEE

Line ® rat

* Analyses that match all of these
criteria will be displayed.
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e Backfill each of the calculations for the past 30 days (“*-30d”):

Start | *-30d Eif

End |© i
What should we do with existing data?
() Leave existing data and fill in gaps
@ Permanently delete existing data and recalculate
Recalculate dependent analyses

Recalculation time range for dependent analyzes
may get expanded depending on analsis
configuration,

[ 1] Queue

Recalculation will permanently delete all the
data within the time range. For event
frames this will result in loss of annotations
and acknowladgements,

e Find the Configuration\3.2.2 Example Analysis. Enable it and backfill it for 30 days. It must be the
last analysis that you choose to backfill. This analysis will “tamper” with the data a little bit for
the last section of the lab:

[ ]

O @@ @} Star Bearing Company\Equipment List\Bore Grinding Equipme
@ fisy  Configuration)3.2.2 Example Lathe0o
[ (] et | Star Rearing Comnanv\Rallina Flament line Rar

Operations

Enable | Disable selected analyses

Enable | Disable automatic recalculation for selected analyse:

BackfilllRecalculate selected analyses

Start I‘-Bﬂd |€_n1
End |* i
What should we do with existing data?
() Leave existing data and fill in gaps
(@) Permanently delete existing data and recalculate
Recalculate dependent analyses

Recalculation fime range for dependent analyses
may get expanded depending on analysis
configuration,

Queue |

Recalculation will permanently delste all the
data within the time range. For event
frames this will result in loss of annotations
and acknowledgements.
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4. Directed Activity — Creating a Pl Vision Dashboard

4.1Context

Pl Vision is already installed an up and running and they have made some progress displaying their newly
created OEE metrics in Pl Vision but there is still some work to do. Here is what the final result should look
like:

O Pl Vision © New Display

@  discrote manutoctuing_OFE Proces.  Asset: | BoreGrderooss ¥ « Ad Hoc Display

@ S'An .. . ; N & E P ) Overall Equipment Effectiveness (OEE)

BEARINGS COMPANY C 7
EMPIRE QUALITY BEARINGS AND MORE 4 2 \ N

,‘:- y Process Line Summary and Equipment OEE Details

BY EQUIPMENT TYPE EQUIPMENT DETAILS

Bore Grindng OEE KPis of the Latest Hour

Chamfer

Stallon A Processlne  Machine Type | Machine S
Outer Ring Lame
QOuter Ring Lathe
Palishing CNCLA n Outer Ring Late BoreGrinder006
Ring Polishing OuterRing  Rough Grooving 75 006 Part Count: 5
OuterRing  Rough Grooving Mazak Product 6921
Rough Grinding n OuterRing | Rough Grooving
Rough Grooving n InnerRing | Heat Treatment u o | ; > 00 A Cycle Time:  540's
InnerRing  Heat Treatment ] s . 000AM  Machine State Running
BY PROCESS LINE am : OuterRing | Face Gindng
Outer Ring Face Ginding
OuterRing  Face Ginding
Outer Ring Outer Ring Bore Grinder
Outer Ring Bore Grinder
Outer Ring Bore Grncer
RingPotsher0! o InnecRing  Ring Polisning

Inner Ring

Rolfing Element

EQUIPMENT ALARM
RingPolisher002 InnerRing  Ring Folishing

RingPoiisher03 Station & \aner Ring Ring Polishing

211172019 9:45:10 PM

m e 5 9

In this exercise, you will start with an existing page and add the missing symbols to properly show the
OEE metrics page.

If you had difficulties with the previous chapter, you can use the AF database solution located on
C:\Users\student01.PISCHOOL\Desktop\Exercise files

| [+ = | Exercise files

Home Share View
T | C:h\Users\studentD1.PISCHOOL\Desktop'\Exercise files|
Marne Date modified Type Size

7 Quick access

B Desktop i HierarchySlicer.pbiviz Microsoft Power B... 49 KB

|| PIVision.bak BAK File 47279 KB
¥ Downloads @] PowerBl Solution.phix Microsoft Power B... 632 KB
=] Documents 2| Star Bearings Company Blankxml ¥ML Document 1,138 KB
=/ Pictures 2| Star Bearings Company Solution.xml XML Document 1450 KB

Exercise files
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To import it select File — Import from File... and pick Star Bearings Company Solution.xml|

€D \\PISRVOT\Star Bearing Company
File | Search View Go Tc
{ @ Database.. Ctrl+Q )

¥ Query Date...

@ Server Properties...

Connections..,

Check In Ctrl+5

Undo Check Out
oo Mheck Hu m Impert from File X
Lead Library...

g &

Save as Library... 0

Import Options

New Model Alow Create [ create or Update PI Points
Allow Update [ Preserve Unique IDs
Automatic Check In

Mew Element

Import from File...

Export to File..

&8 w@E

Exit Cancel

4.2Directed Activity — Adding symbols to Pl Vision

e Use the Pl Vision shortcut m on the Desktop to navigate to SBC’s Pl Vision page.

e C(Click on Favorites, you can use that tool to mark some of your favorite displays. In this case we
have included the discrete manufacturing home display. Click on it:

@ ichanced Edton X @ Piviion « B - 8 x
€ 5 C @ nupsspner pschootinn
O P Vision
Show private displays
[oRS—
= AllDisplays
& Favortes
[ My Displays
© Recent

@ Home

= Discrete Manutacturing >

This page acts as the homepage. Links that look like a toolbar (in gray) have been added to navigate
between pages. Take note that some of the linked pages are still in construction and will not work for this
lab.

O piVision © New Display

(s discrete manufacturing_Home

BEARINGS COMPANY
EMPIRE QUALITY BEARINGS AND MORE

71 oeE AnALYTICS

Products
Services

Detroit, Ml 4 4
USA % Industries Served

Contact Us

Stuttgart, BW
Germany
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e Click on SHOP FLOOR:
[roe [ oo | roorowne | ucrmvonumer | mncom o |

This page provides an overview of each of the stations. The arrangement also represents SBC’s
process:

Pl Vision

discrete manufacturing_ShopFloor  Asset  Station 3 ¥

Inner Ring
Materials:

Tubing Bar

AIS! 52100 Al good Al good

Tuming Chamlering

Face grinding Bore grinding Ring Polishing

Allgood Al good Al good

Heat treatment
Outer Ring m Al good =2 ﬁ

Materials: Tuming Rough grooving

Tubing Bar Face grinding Bore rough grinding Race honing

AISI 52100 A geod All good Al good All good All good Bearing Assembly

Inspection and Packing

Rolling

B \ e

emen s
BN S () M

Materials: m m __ I

Chromium Alloy Slugs o 3 Polis
15152100 Rough grinding Heat treatment Fine Grinding Polishing

All good All good All good All good

e Next, click on the OEE tab: Eaiaesiias iy

The navigation bar is actually made out of text and rectangle objects that have

' been configured to look like a navigation links. Each “tab” of the bar is a different

@ Pl Vision page and since the links are consistent between pages the users will think
Tip of this as a navigation bar.

This display shows the OEE metrics of all of the Bore Grinders in the middle. If you click on any of the Bore
Grinders in the table, the specific OEE metrics and additional information will be displayed on right side

of the display. Depending on the OEE value, the color of the values will change from green to orange to
red.
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discrete manufacturing_OEE_Equip_... Asset: | BoreGrinder002+ V¥ « Ad Hoc Display ED

- —r L N g : , '
@ SI'AII e ol é . & Ay 3, 3 Overall Equipment Effectiveness (OEE)
st il e . 4 ‘:f_ — 38 .-. Equipment Type Summary and Equipment OEE Details
HOM )

SHOP FLOOR PRODUCTION LINE LINE PERFORMANCE INLINE QUALITY ANALYTICS
BORE GRINDING EQUIPMENT SUMMARY

EQUIPMENT DETAILS
Bore Grlndlvq Equvpmem OEE KPs of the Latest Hour BoreGrinder002  OEE KPIs of the Latest Hour

N

0w 0
73611 % F45 25 25%

QuaLTy
e Bore Gnndlng Equlpment List t BoreGrinder002
S— i < Equipment No 002 Part Count 5

e Procassline | MachineT... Machine S... Avaiabilty | Performance  Qualty Manufacturer OKUMA Product: 6921

BoreGrinder0d1 Stato reer Rin Bore Grinder Rui Mode! Cycle Time 540 =
Rough Grooving . =  Gincr 5

2016 5:00:00 AM Machine State: B
i
9 6:00:00 AM SEg o o
BY PROCESS LINE

Inner Ring 005 Statn'5 Outer Ring | Bore Grnder
Bare Grinder
Quter Ring
Rolling Element
EQUIPMENT ALARM

ANI2019 14:17:53 AM - VN20197A7:53 P

e Take a look at the links on the left and click on Lathe. The users can browse the same page by

equipment type and by process line. Only the Bore Grinding and Lathe pages and the ones for the
process line have been built so far:

BY EQUIFMENT TYPE
Bore Grinding
Chamfer
Face Grinding
Fine Grinding
Heat Treatment
Lathe
Palishimg
Ring Polishing
Rough Grinding

Rough Grooving

BY PROCESS LINE
Inner Ring
Outer Ring

Rolling Element

EQUIPMENT ALARM

[ |

You might find errors in this page, this is intentional. The page needs some work.

e Start by enabling the build mode @ by clicking on the icon.

e Then, move the rectangle over the lathe in the left menu. As you can see, the “Menu” is just a
rectangle!
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Heat Treatment

The middle of the page is dedicated to OEE metrics for the equipment group, which is the Lathes for this
particular page:

LATHE EQUIPMENT SUMMARY

Lathe Equipment OEE KPIs of the Latest Hour

86.111

AVAILABILITY

Lathe Equipment List

(Double-click on equipment in list to view more details >> )

The Availability is already done, you have the choice to either copy and paste the objects or build it from
scratch for the performance and quality.

e To add the gauge, drill down to the Star Bearing Company\Equipment List\Lathe level and select

the Gauge symbol and then drag the performance attribute in the middle:

e Right click on the gauge and select Format Gauge...

Convert to Collection...

Switch Symbolto  »
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e Try to change the settings to obtain a gauge that is similar to the one for the
availability:

Format Gauge v

vSty}e

Type Pointer

Angle O—
QUIPMENT SUMMARY EQUIPMENT DE Indicator . v

the Latest Hour No Data OEE KPIs of the Latest Hour Size _O._
50

Fill A v

Outline A v

Weight -O_
Equipment Name No Data

v more details >> ) Equipment No, Scale |:| v
Manufacturer:
Model
Installation Date:

Format Database v

e To do the Quality gauge, use the copy/paste feature of Pl Vision. Select the gauge you have
created and either use the copy button or hit Ctr/ + c:

@ PlVision - discrete manufacturic. X 4

< c @ https://pisrv01.pischoolint/PIVision/#/Displays/331972/discrete-manufacturing_OEE_Equip_Lathe

Q! Pl Vision
@ Assets discrete manufacturing_ OEE_Equip__. * Asset |Lathe ¥

W B E B w0k B 0 ¥ AR T By xgvT

Search in Equipment List s'A

BEARINGS COMPANY
EMPIRE QUALITY BEARINGS AND MORE
< Home

< Star Bearings Company

LATHE EQUIPMENT SUMMARY

Er Lathe Equipment OEE KPs of the Latest Hour
) Bore Grinding o5 o
o

@ Chamfer

Face Grinding

& Face Grinding

Fine Grinding

@ Fine Grinding Heat Treatment 86.111

AVAILABILITY
@ Heat Treatment Lz

P Lathe — Lathe Equipment List
B Ring Polishing (Double-click on equipment in
Q) Polishing

Rough Grinding
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e C(Click on paste and move the gauge on top of Quality. The newly created gauge still shows
the data for the performance. To fix it, select the quality attribute and drag it on the gauge:

@ PIVvision - discrete manufacturin. X 4

&« c 8 https//pisrv01.pischool.int/PIVision/#/Displays/331972/discrete-manufacturing_OEE_Equip_Lathe

discrete manufacturing_OFF_Fquip_.. * Asset

0 ¥ BB O By xovT

EA G5 COMPANY

ENFIRE QUALITY BEARINGS AND MORE

£ Star Bearings Company PRODUCTION LINE
£ Star Bearing Company
. . LATHE EQUIPMENT SUMMARY
Equipment List

@) Bore Grinding

@ Chamfer

Lathe Equipment OEE KPIs of the Latest Hour

40 5 @ . = _
30, 30 7
Face Grinding 20,
10, B
L [
Fine Grinding )7 w0 ok Qualityion

@ Face Grinding

0t

ekl -

Lathe.

&) Fine Grinding

VW VY vV v

&) Heat Treatment

o Use the same methodology to fill out the values underneath each gages. If time permits, also fill
in the information on the right part of the display for the Star Bearing Company\Equipment
List\Lathe\CNCLathe003

EQUIPMENT DETAILS

NoData OEE KPIs of the Lalesl Hour
=] L
- 00 - .
00
- _ -

Equipment Name: No Data
Equipment No Part Count: No Data

91.667 %

AVAILHBILITY

Manufacturer: Product:
Model:
Installation Date:

Cycle Time:
Machine State:

Last Maintenance Date:

87:4T46 FM

e Select the Asset Comparison symbol N and navigate to Star Bearing Company\Equipment
List\Lathe\CNCLathe001 and select Asset, Station, ProcessLine, Machine Type, Machine Status,
Availability, Performance and Quality:

! You can hold down the Ctrl key to pick multiple attributes at the same time.

Tip
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0 Pl Vision

@ Assets iscrete manutacunng_OEE_Equip_
W B =B

) CNCLathe0D1 S SR

) GNCLathe002 . n
) CNCLathe003 - -
) CNCLathe004

£ GNCLathe005
) CNCLathe006

Atfributes
=

=] Availability
= OEE
=] Performance EQUIPMENT ALARM

= Quality
= CyckeTime
= Machine State

=] Product

= RunningTime 19 7:54:03 PM 2019 T:54:05 PM

whacturir X | 4 - 8 x

.pischoolint - % O

O piVision
©  Assets discrete manutaciunng_OFE._Equip_ CNCLatheonas ¥

EQUIPMENT DE
) CNCLathe001 il

@ CNCLathe002
) CNCLathe003
) CNCLathe0D4
@ CNCLathe005
) CNCLathe006

11
ALABILITY

No Data

Waching T_. | Wochineti__ | Processiivs | Staion
Labe _ CHCLainOT1  Oum Fivg
Aftributes
CNCLathe004
Asset Management
=l Machine Type
i MachineName EQUIFMENT ALARM
[EINo
[=] ProcessLine

Elinstaliation Date

[E] Last Maintenance Date

& Manufacturer

=] Model
< |
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e Right-click on it and select Configure Table...

Lathe Equipment List

(Double-ch

o}
Asset

CNCLatheD01
CNCLath002

on equipment in st to view more deta

o
[ Performance

o
| Machine T | MachineN._. | Processiine | Station | availabitty

Quter Ring

Configure Table..

CNCLatheD03

Add Multi-State...
Add Navigation Link..
Add Dynamic Search Criteria...

Switch Symbol to >

© NewDisplay | Fz;o | PiscHooLsentot | @ [

« Ad Hoc Display m I}

LATHE EQUIPMENT SUMMARY

Lathe Equipment OEE KPIs of the Latest Hour
50

AVAILABILITY

the Equipment List

uble-click on equipment in list to view more details >> )

T Frocesstine | Wadhne s | Availability Performance | Quality
Outer Ring Running 75 75

Outer Ring | Running | 83333 75 |

Outer Ring Running 01887 )

Inner Ring idie 91,687 [

Inner Ring Running 01887 )

Inner Ring | e | 83333 75 |

| station
Station 1
Station 1 |
Station 1
Station 1
Station 1
Staion 1 |

EQUIPMENT DE

OEE KPIs of the Latest Hour

)

No Data

40 50 60
“%

= 100
91.667 %

AVAILABILITY

Equipment Name:
Equipment No:

No Data
Manufacturer.
Model

Installation Date:
Last Maintenance Date:

Part (

Bad Part Count

Ronoo-m

1212010 7:67:37 PM

e Sotonos «

&

Configure Table v

v Columns

Current Columns:

Asset

Station
ProcessLine
Machine State
Availability
Performance
Quality

Show Units

Additional Attributes:

Manufacturer &
Model

No

OEE

Part Count
Product
RunningTime

==

o The last step is to configure the multi-states to make the color change depending on each OEE
metric value. Start with the table, right-click on it and choose Add Multi-State...

Lathe Equipment List

(Double-click on equipment in list to view more detail

| station

Station 1

L
CNCLatheD01
CNCLatheD02
CNCLatheld3

Outer Ring
Station 1 Outer Ring
Station 1 Quter Ring
San
Station 1 Inner Ring

Inner Ring

o
| Processtine | Machine ...

| Availability [ Performance [ Cluality

Running

Configure Table...
Add Multi-State...
Add Navigation Link...

Add Dynamic Search Criteria. . '

Switch Symbol to -
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e Select Availability and click on Enable Multi-State then configure it as follow:

¥ Columns

Current Columns:

Asset

Station
ProcessLine
Machine State
Availability
Performance
Quality

+| Enable Multi-State

. Bad data

ls 100 [
< 90 [x]

ls 70 |X]
> 0

e Repeat the same configuration for Performance and Quality. If time permits, add multi-state to
the rectangles underneath each gauge:

ANAILABILITY

e The last step is to add a navigation link in the Asset Comparison Table. That will act as a way to
choose which lathe will be displayed on right side. To add the navigation link right-click on the
table and select Add Navigation Link...

Lathe Equipment List

(Double- n equipment in i

Station | ProcessLine | Machine 5 | Avallabilty | Performance | Quality
Staben 1 Outer Sing Running 75 75
CNCLath=D03 Station 1 Outer Ring Running -1 75
CNCLatheDD4 PEEET Configure Table...
Station 1 Inner Ring
CNCLatheDDS Inner Ring

Configure Multi-State
Add Navigation Link

Add Dynamic Search Criteria...

Switch Symbol to >
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e Select Change context of current display in the options:

Add Navigation Link -

Action

Open hyperlink to another page
8 Change context of current display

® Use current asset
Use current asset as root

If you had time to fill in the gauges for the equipment and other missing information you will see that
clicking on any of the assets in the Asset Comparison Table will change the asset on the right side of the
display. If you didn’t had time to complete this part, save your display then click on the Bore Grinding
operation and try to click in the Asset Comparison Table:

LATHE EQUIPMENT SUMMARY EQUIPMENT DETAILS

Lathe Equipment OEE KPIs of the Latest Hour CNCL%heOOZ OEE KPIs of the Latest Hour

40 50 f 40 50 60
/ 30 70
20 80
‘ 1 -~ i B [ -~

%
- o ~ 100
79.167 83.333 %

AVAILABILITY AVAILABILITY

athe Equipment List Equipment Name No Data

bouble-click on equipment in list to view more deta Equipment No: Part Count: No Data
Manufacturer. Product

Model Cycle Time:

Installation Date:

Last Maintenance Date:

| Processtine | Machine S... | Availabifty | Performance | Quaiity
CNCLathe001 Siston ! OuerRing Running
CNCLathe002 Station 1 Outer Ring Running Machine State:

Outer Ring Running

Running

Running ..
Part Count

BY EQUIPMENT TYPE BORE GRINDING EQUIPMENT SUMMARY EQUIPMENT DETAILS

CEDELhy Bore Grinding Equipment OEE KPs of the Latest Hour BoreGrinderd02  OEE KPIs of the Latest Hour

Chanmer
Face Grinding
Fine Grinding

Heat Treaiment 80.556 83.333 %
AVAILABILITY.

QuaLTy AVAILABILITY
Lathe

ey Bore Grinding Equipment List Equipment Name BoreGrinder002
(Double-click on equipment in list to view more detail Equipment No: 002
Manufacturer: OKUMA Product:

Rough Grinding
Station § Innes Ring | Bore Grindar Running Modsl: Cycle Time: 5
Rough Grooving Station 5 Inner Ring | Bore Grinder Running Installation Date: 5/8/2016 5:00:00 AM —
Machine State: Running

Ring Polishing Part Count:
Station Processline  Machine T.. Machine S... Availabiity  Performance  Qualty

Last Maintenance Date:  2/2/2019 6:00:00 AM

Station 5 Innes Ring | Bore Grindr Running. |
BY PROCESS LINE Sion | GuerRing | Bore Grinder Running oo |
Sion 5 CutrRing | Bore Grinder Running |
Swion5 | OuterRing | Bora Grinder Running
Part Count
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5. Directed Activity — Analyzing the data in Power Bl

5.1Context

In addition to their PI Vision dashboard, the Star Bearing Company would like to have a report where
they can drill down the OEE data. They already have Microsoft Power Bl and the Pl Integrator for
Business Analytics installed and running for another project so they are going to use these tools for this

report.

Here’s an example of the final result:

Star Bearing Company - OEE Analysis

Line Template | Average of Perfermance  Average of Availability | Average of Quality

Inner Ring |
Line Template Outer Ring
40 Inner Ring Ralling Element

40 station 1 Total 76.07 79.58 99.06
O CNCLathe004
O cNCLathe00S
O CNClathe006
» O Station 2
+ O station 3
+ O station 4
» O Station 5
» O Station 6
+ O Outer Ring
» O Rolling Element

Average of Performance @ Average of Availability @ Average of Quality

100
60
40
20
0
2 4 5

Idle

Stopped

Unplanned Stopped

Running

TimeStamp

3/1/2019 3/7/2019

O O

5.21Directed Activity — Using the Pl Integrator for Business Analytics

e Open the Pl Integrator for BA webpage using the desktop link

e You might get a prompt to connect to the Integrator webpage. The username is
pischool\student01 and the password is the same one you used to login to the

environment:
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Signin
hitps://pisrv01 pischoolint:1313

Username pischool\student01

Password | sessssesssssresssns |

m Ca”EEI

e Click on Create Asset View, name the view OEE Metrics

Advanced Edition x|+

@
< C @ hups//pisnOt.pischootint

Last Fun Time [=
Feb 21,20197.3757 P

End Tme

Run Status Run Moge
Published

Name
(OEE Melrics Solution

Once

Create New Asset View

Asset View Name

OEE Metrics

e C(Click on Create a New Shape

import a shape from an existing view or create a new one

Create a New Shape

Import a Shape from Ancther View
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o Select all of the attributes and drag them in the middle pane.

@ Advanced Edition % (@ PlVision - discrete manufacturin. X | @ Advanced Edition x | +

< C & httpsy/pisrv01 pischoolint:1313/Designer

OEE Metrics Solution

Select Data > Modify View > Publish

D) Source Assets v @ Search Shape  Matches

Server P s T, Asset Shape Found 42 Matches

rilizae Star Bearings Company o v * @ e Template #% | > Ounariig

4 station Template #x ¥ @innerRing

AR 4 @ equipment #% » EmerRing

» @ Configuration - & Availability #£x  » @imnerRing

4 () Star Bearing Company # Bad Part Count #x » @imnerRing

4 (D Equipment List [ CycleTime # % » @innerRing

» @ Bore Grinding [ElInstallation Date # % ¥ ©@innerRing

» @ chamfer [E] Last Maintenance Date #% > @innerRing

» @ Face Grinding & Machine State # % » @innerRing

» @ Fine Grinding =] Machine Type #x » Q@imerRing

» () Heat Treatment =] MachineName #x » @linnerRing

4 @lathe [l Manufacturer #x » @nnerRing

@ CNCLathe001 =] Model #%x » @innerRing

D CNCLathe002 ElNo #x » QinnerRing

€ CNCLathe003 . & OE #x » QinnerRing

: - - - & Part Count #%x ¥ @innerRing

Attributes & Performance #x ¥ @innerRing

[l ProcessLine #x @ outerRing

& Deselect All B #x » @ outerRing

# Availability el- ® quality #x » BouterRing

4 Bad Part Count [i] # RunningTime # % » @ outerRing

CycleTime (i) Station #x » QouterRing

Installation Date [i] » [ OuterRing

Last Maintenance Date [i] » [ outerRing

» & Machine State [i] » [ outerRing

Machine Type [i] » [ outerRing

MachineName [i] » [ outerRing

Manufacturer [i] » ) outerRing

4

e Clickonthe Pen # icon next to the Inner Ring element and Uncheck Asset Name and select
Asset Template:

Edit Filters x

Asset Name

| Inner Ring |

#| Asset Template Search Derived Templates

‘ Line Template v

Asset Category

() Add Filter

Gancel m
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e Repeat the same procedure for the Station Template and Equipment:

Select Data >
) Source Assets.
Server

Database

0 Assets

) configuration

4 () Star Bearing Company

» @ Equipment List

laintenance Date
E-Nnnenn Aks

e Yous

The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

Edit Filters

Asset Name

x

| Station 1

| Asset Template Search Derived Templates

Station Template

Asset Category

() Add Filter

Cancel m

x 4

ttps://pisrvO1.pischoolint

Modify View > Publish

w (D) Search Shape
% Asset Shape
4 ) Line Template

4 @ station Template

hould now see 42 Matches in the right pane, click on Next.

 Matohes

Found 42 Matches
Zx » QinnerRing
# % » QinnerRing
/% » @innerring
| ) e iy
2% » Qinnerring

Change the Start Time to *-7d, the report will use 7 days of data. If you have more time to wait,

you can change the Start Time for the past month (*-1Mo) to have a bigger dataset:

2 I

Start Time End Time
*7d
Machine State ) Machine Type OEE
M hamfar E7 R L

i Dunnina

Part Count

Performance

iTR

RunningTime
') 2294 219

Product

ica

Click on Edit Value Mode and change the Sample values every option to 10 minutes.

Edit Value Mode

® Sampled Values
# Sample values every
® Interpolate @
Exact @

Use Key Column | Availability v

x

Cancel Save Changes
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e Click on Next and select MYBIViews as the Target Configuration. Click on Publish

Select Data > Modify View > Publish

Target Configuration Overwrite Options Summary

MyBIViews v The selected target only supports overwriting old data Shape and Matches

+ There are 42 Matching Instances

Run Mode Timeframe and Interval
® Run Once « Your Start Time is *-7d
s Your End Time is ®
Run on 3 Schedule = Your Time Interval gets an interpolated measurement Every 10
minutes

Publish

It will take a 2-3 minutes to generate the data. You can see the progress in the bottom bar:

Overview Leg Security View Configuration Statistics

Run Status Publishing 4%
-

View Name OEE Metrics Solution

e When the view is fully published, you can close the Pl Integrator webpage.

5.3Creating the Dashboard in Microsoft Power Bl Desktop

e Open the Power Bl Exercise file using the shortcut on the desktop

[}

Get
e Click on Get Data - :and select SQL Server database

x

Get Data

All
All Excel .
File B Tea/CSV
Database f XML
Azure [2] Json
Online Services Folder
QOther w SharePoint folder

SQL Server database

B Access database
SQL Server Analysis Services database
Oracle database

IBM DB2 database
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Enter PISRVO1 in the Server field

X
SQL Server database
Server (i
PISRVO1
Database {optional)
Dats Connectivity mode @
® Import
DirectQuery
1 Advanced options
ok Cancel
Select Use my current credentials
SQL Server database X
pisrv01
Use your Windows credentials to access this database,
Database
® Use my current credentials
Microsoft account Use alternate credentials
Back Connect Cancel

Choose the OEE Metrics view in the MYBIViews. You should see data in the right tab. Click on
load. You should now see a blank canvas.

o X
Navigator
» OEE Metrics [
Display Options ~ [ Id Line Template TimeStamp Station Template Equipment

4 PISRVO1 [6] 1 Inner Ring 2/13/2019 6:38:35 PM Station 1 CNCLath
LT MyEViews 2] 2|Inner Ring 2/13/2019 6:39:35 PM Station 1 CNCLath
3 Inner Ring 2/13/2019 6:40:35 PM Station 1 CNCLath

¥ E OEE Metrics
4 Inner Ring 2/13/2019 6:41:35 PM Station 1 CNCLath
B OEE Metrics1 5 Inner Ring 2/13/2019 6:42-35 PM Station 1 CNCLatH
p & PIFD & Inner Ring 2/13/2019 6:43:35 PM Station 1 CNCLatt
b [ PlintegratorD8 7 Inner Ring 2/13/2019 6:44:35 PM Station 1 CNCLath
b B Plntegratorlogs 8 Inner Ring 2/13/2019 6:45:35 PM Station 1 CNCLath
9 Inner Ring 2/13/2019 6:46:35 PM Station 1 CNCLath

b PlintegratorStats
10| Inner Ring 2/13/2019 6:47:35 PM Station 1 CNCLath
4 PlVisien 11 Inner Ring 3/13/2019 6:48:35 PM Station 1 CNCLatH
12|Inner Ring 2/13/2019 6:49:35 PM Station 1 CNCLath
13 Inner Ring 2/13/2019 6:50:35 PM Station 1 CNCLaH
14 Inner Ring 2/13/2019 6:51:35 PM Station 1 CNCLaH
15 Inner Ring 2/13/2019 6:52:35 PM Station 1 CNCLaH
16 Inner Ring 2/13/2019 6:53:35 PM Station 1 CNCLath
17 Inner Ring 2/13/2019 6:54:35 PM Station 1 CNCLath
18 Inner Ring 2/13/2019 6:55:35 PM Station 1 CNCLath
19 Inner Ring 2/13/2019 6:56:35 PM Station 1 CNCLath
20 Inner Ring 2/13/2019 6:57:35 PM Station 1 CNCLath
21 Inner Ring 2/13/2019 6:58:35 PM Station 1 CNCLath
22|Inner Ring 2/13/2019 6:59:35 PM Station 1 CNCLath
23 Inner Ring 2/13/2018 7:00:35 PM Station 1 CNCLath

< >

Select Related Tables Load Edit Cancel
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e Find the Fields section in right pane and Right click on the LineTemplate and select New
hierarchy:

Add filter

MNew hierarchy
MNew measure
Mew column
Mew guick measure
Rename
Delete

Hide

View hidden
Unhide all
Collapse all
Expand all
MNew Group

Properties

e Drag Station Template then Equipment on the Line Template hierarchy:
4 M " : Line Template...
B Line Template
W Station Tem...
W Equipment

e Create a new HierarchySlider . and drag the Line Template hierarchy in the Fields section:

JEE Metrics
r = = W 5 Availability
Line Template N = Bad Part Count
» . Inner Ring M Equipment
i Id
» L1 Quter Ring |
Last Maintena...
» ' Rolling Element : aintena,
Line Template
<+ [ °: Line Template...
Line Template Hierarchy = ”‘_ smp
! 1 Line Template Line Template
Station Template Station Term..
Equipment Equipment
B  Machine State

The HierarchySlider provides a hierarchy similar to the one in SBC’s AF structure. You can select objects in
there and the canvas will display the metrics only for your selection. The next step is to add the OEE
metrics.

38| Page



The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

e You are going to use the Matrix tool n Drag the Line TemplateHierarchy in the Rows, the
Avadilability, Performance and Quality in the Values field.

e Change the Availability, Performance and Quality fi_g!ds to Average:

Sum

+/ Average
Minimum
Maximum
Count (Distinct)
Count
Standard deviation
Variance
Median
Show value as »

MNew guick measure

Performance

Quality

e Go to the format tab and select Conditional Formating and enable Background color:

~ Conditional formatting

Average of Availability -

Background color

e Go to Advanced controls and change the Minimum to Number and enter 75. Repeat for the
Quality and Performance.

Background color - Average of Availability

Format by Learn maore

Based on field Summarization Default formatting ©

| Average of Availability - | | Average r | Aszero '|

Minimum Maximum

MNumber r . - |l—ighestva|ue r ||. - |
Diverging
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e Your table should like this (the values and colors will be different):

- — = .1

) (@& (D)

r

Line Template Average of Availability | Average of Performance  Average of Quality

Inner Ring
Quter Ring

Rolling Element
Total 79.53 75.99 99.04

e Add aslider E and drag the TimeStamp. You can use the slider to change the timerange of
the OEE display.

TimeStamp

2/28/201% 3/8/2019
O O

e AddaPlChart ﬂ and drag the Machine state in both Details and Values fields:

r = & -1
Count of Machine State by Machine State
Idle
Stopped
Unplanned Stopped
1 1
Machine State
Values
Running Count of Machine State
Tooltips
kL - ol

Add data fields here
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Now that you have a basic OEE Power Bl dashboard, try to find any issues with the equipment. You can

i
=

use the double arrow symbol " to drill down in the data. Is there any machine(s) that are
problematic? If so, what’s the issue? The solution can be found in the solution section.
r o - ™ A ..o ¥

| —_— I =

|£| |

Line Template Average of Availability | Average of Performance  Average of Quality

Inner Ring
Cuter Ring
Rolling Element
Total 79.53 75.99 99.04

Try to add more visualization symbols and use the other attributes such as the Machine State or the
Product to complete your dashboard.

e Take a look also at the EEEEL and compare it to your own dashboard.

That’s it! You have created the OEE metrics, added the KPIs in a Pl Vision page and created a Power BI
dashboard in a short period of time. If you want to import any of the data such as the AF Structure, Pl

Vision dashboard and Power Bl file, you can grab them from the Exercise files lE&&581lS folder on the
desktop.
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6. Solution

3.2.1 OEE Calculations

MName Expression Output Attribute
IF(Minute('*') = 1)
EndInt 1 . Map |
natneerva THEN ParseTime(Concat("T+", Hour{'*')}, "h"))
ELSE **'
Mirutel FTy = i vey
ElapsedTimeSec IF(Minute('®") = 8) OR (Minute("*'} = 1) Map
THEN 3599
ELSE((Minute("*") - Minute(BeginInterval))®6@)-1
PostingTime Map
If(Minute('*") <» 1) THEN BeginInterval ELSE ParseTime({Concat("T+", Hour('*')))
varfvailability| Convert('RunningTime'/3608,"ratio") Awvailability
varPerformance |Convert('Part Count' / (360@ / 'CycleTime'),"ratio") Performance
varQuality Convert(('Part Count'- 'Bad Part Count'})/’'Part Count',"ratic") Quality
varQEE Convert(varAvailability*varPerformance*varQuality, ratio™) OEE

The Convert function is an elegant way to handle unit of measures within a calculation. In this case, the
ratio UOM represents 100%. The results of any of the OEE metrics will be within 0 and 1 but the users
will want to show the results in percentage (0-100%). This is done by setting up the attribute UOM to
Percentage. By leveraging the Convert function we don’t have to divide by 10000 (Ex: 0.9*0.9*1=0.81
instead of 90*90*100/10000 = 81).

5.3 Power Bl dashboard

The CNCLathe004 should have a low Availability because it’s in a Stopped stated for a greater proportion
of the time compared to the other equipment. The performance is also affected because it’'s not
machining enough parts.

42 |Page



The Pl System in the Manufacturing Line — Calculating OEE Across Your Factory

Have an idea how to
improve our products?

OSlsoft wants to hear
from you!

https://feedback.osisoft.com/

A
4
a
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OSlsoft.

Pl World

Save the Date!

OSlsoft Pl World Users Conference in Gothenburg, Sweden. September 16-19, 2019.

Register your interest now to receive updates and notification early bird registration opening.

https://pages.osisoft.com/UC-EMEA-Q3-19-PIWorldGBG-
ReqgisterYourlnterest RegisterYourinterest-LP.html? ga=2.20661553.86037572.1539782043-
591736536.1533567354

&l I%sisif}Vorld

GOTHENBURG
Sept. 16 - 19, 2019

44 |Page


http://pages.osisoft.com/UC-CORP-Q3-18-EMEAUsersConference_RegisterYourInterest2018.html

	Table of Contents
	1. Introduction
	1.1 Star Bearing Company
	1.2 Lab objectives

	2. Directed Activity Exploring the AF Structure
	2.1 Context
	2.2 Step by step tasks

	3. Directed Activity – Adding the OEE Metrics
	3.1 Context
	3.2  Step by step tasks
	3.2.1 Create the OEE metrics for the machines
	3.2.2  OEE Calculation scheduling explain
	3.2.3 Create the OEE metrics for the lines, stations and equipment groups
	3.2.4 Backfilling the OEE results


	4. Directed Activity – Creating a PI Vision Dashboard
	4.1 Context
	4.2 Directed Activity – Adding symbols to PI Vision

	5. Directed Activity – Analyzing the data in Power BI
	5.1 Context
	5.2 1Directed Activity – Using the PI Integrator for Business Analytics
	5.3 Creating the Dashboard in Microsoft Power BI Desktop

	6. Solution
	Save the Date!

